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This guide is for Filr 3.0 administrators and covers various Filr administrative tasks that come into
play after your Filr system is deployed and providing services to end users.

Audience

This guide is intended for Filr administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the comment on this topic link at the bottom of each page of
the online documentation.

Documentation Updates

For the most recent version of this guide and other documentation, visit the Micro Focus Filr 3.0
Documentation website (http://www.novell.com/documentation/filr-3).
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Additional Documentation

You can find more information in the Micro Focus Filr documentation, which is accessible from the
Micro Focus Filr 3.0 Documentation website (http://www.novell.com/documentation/filr-3).
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1 Access to Filr—Maintenance Tasks

All of the links below point to rows within Ul help tables in the Filr 3.2: Administrative Ul Reference.
See the Path statements before each table for Ul navigation help.

Desktop Application Access

+ Desktop Default—Enable/Disable
+ Desktop Selected Users—Enable/Disable

Guest User (Public) Access

¢ Guest (Public)—Enable/Disable

Local User (non-LDAP) Access

+ Local (non-LDAP) Users—Enable/Disable

Making Public URLs Searchable

You can provide Internet search engines (such as Google) with the Filr permalinks for folders that you
want to make publicly available on the Internet.

1 Access the folder in Filr.
2 Click Permalinks at the bottom of the folder page.

Mobile Device App Access

+ Mobile Default—Enable/Disable

+ Mobile Selected Users—Enable/Disable

Web Browser Access

+ Web Default—Enable/Disable
+ Web Selected Users—Enable/Disable

Access to Fil—Maintenance Tasks 11
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Adding a Filr Appliance to an Existing
Deployment

To accommodate additional load, you can add Filr appliances to the Filr system only if your original
Filr system was configured with shared storage (/ vashar e).

+ “Prerequisites” on page 13

+ “Adding Filr Appliances to an Existing Deployment” on page 13

Prerequisites

You can add a Filr appliance to an existing Filr deployment only if your Filr deployment meets the
following prerequisites:

+ |tis an expandable deployment: Small (all-in-one) and non-expandable Filr deployments
cannot be expanded.

+ Shared storage is enabled: Ensure that a shared storage CIFS or NFS mount (/ vashar e)
exists for the Filr deployment. You configure shared storage during the Filr appliance installation,
as described in “Setting Up Shared Storage” in the Filr 3 Installation, Deployment, and Upgrade
Guide.

IMPORTANT: If shared storage (/vashare) was not configured at the time you installed your
original Filr system, you cannot add Filr appliances to the system.

+ The CIFS or NFS mount is accessible to all Filr appliances: All Filr appliances in the cluster
need to have access to the CIFS or NFS mount.

+ (Recommended) A load balancing solution is in place: If you want to provide a common
access URL for all your Filr users, you must provide a solution for load balancing between the
Filr appliances.

Micro Focus does not provide a load balancing appliance; however, there are many software
solutions available, such as Apache, HAProxy, and NGinx.

There are also hardware solutions available, such as F5 Networks, Juniper, Riverbend, and A10
Networks.

Searching the web for Layer 4-7 switches or Application Delivery Controller isagood
place to start finding a solution that meets your requirements.

Adding Filr Appliances to an Existing Deployment

To add Filr appliances to an exiting large Filr deployment:

1 Ensure that your system meets the necessary prerequisites.

2 Assuming that you have planned the installation, downloaded the software, and so on, install the
additional Filr appliance, beginning with “Deploying the Virtual Machines” in the Filr 3 Installation,
Deployment, and Upgrade Guide.

The process is the same as when you installed the original Filr appliance.

Adding a Filr Appliance to an Existing Deployment 13



IMPORTANT: Choose the same configuration options (including the same CIFS and NFS
mount) that you chose when you installed the original Filr appliance.

3 Run the installation wizard for a large deployment (at port 9443), as described in “Setting Up the
Filr Appliances” in the Filr 3 Installation, Deployment, and Upgrade Guide.

4 After the configuration is complete, complete the steps in “Completing the Expandable Filr
Deployment” in the Filr 3 Installation, Deployment, and Upgrade Guide.. Then verify that
clustering is enabled and that the Memcached configuration matches the configuration of the
original Filr appliance.

14 Adding a Filr Appliance to an Existing Deployment



Administrative Access Maintenance

+ “Adding or Removing Administrative Rights for Users and Groups” on page 15
+ “Administrative Maintenance—Port 8443 Admins” on page 15

+ “Simplifying Management through Administrative Groups” on page 16

Adding or Removing Administrative Rights for Users
and Groups

See “Assigning and Managing Port 8443 Direct Administrators” in the Filr 3.2: Administrative Ul
Reference.

Administrative Maintenance—Port 8443 Admins

About Port 8443 Administrators

There are two types of Port 8443 Administrators
+ Built in: Have full rights to the Port 8443 console, including the right to add or remove Direct
administrators.

+ Direct: Have rights to administer only
+ Users
+ Groups
+ Mobile Devices
+ Net Folders
+ Net Folder Servers

Modifying Port 8443 Administrators

The modifications you can make depend on the type of user, as follows:

+ Built in admin: You can change this username and password by logging in as the user, clicking
the Username (upper right), selecting View Profile, clicking Edit, and making the changes.
Changing this affects

¢ The name you enter to log in as the built-in administrator
+ The name that appears in the upper-right corner of the Port 8443 console
+ The name that appears in the administration console under Administrators

+ LDAP users (Direct administrators): User names and passwords are controlled in the LDAP
source.

+ Internal Filr users: User names cannot be changed; passwords can.

Administrative Access Maintenance 15



Administrators click the user in the Users list, click the Profile button, and enter a new password.

Internal users edit their profile to change their passwords.

Simplifying Management through Administrative
Groups

You can simplify your management tasks by creating administrative groups and assigning group
members with specific administrative tasks.

For example, Net Folder setup and indexing, etc. is time-intensive.

1. Create a group.
2. Add it to the Administrators list.

See “Assigning and Managing Port 8443 Direct Administrators” in the Filr 3.2: Administrative Ul
Reference

3. Assign users to the group.
4. Task group members with setting up Net Folders.

16 Administrative Access Maintenance



Branding and Changing the User
Interface

+ “Branding Desktop Apps (Advanced-Edition License Only)” on page 17
+ “Branding Mobile Apps (Advanced-Edition License Only)” on page 19
+ “Branding the Web User Interface” on page 34

+ “Changing the Title of the People Page” on page 35

Bralm)ding Desktop Apps (Advanced-Edition License
Only

As the built-in Port 8443 administrator, you can brand your Filr desktop apps to match your
organization’s brand.

IMPORTANT: Direct Port 8443 administrators do not have rights to administer branding.

To customize the branding of the desktop application, you must first create a ZIP file containing the
files outlined in Table 4-1 on page 17.

IMPORTANT: The following files must be directly zipped and should not be contained within a folder.

Table 4-1 Desktop Branding Files

File Name and File Size Sample File Format Description
format
about.png 418 x 200 R To view the about image:
Pixels '-""“ :
@ + On Windows: Right-click
. E and then click About
Fllr World Company Name - Filr.

¢ On Mac: Click Eh and
then click About
Company Name - Filr.

NOTE: Ensure that your
custom branded image is of
the same size as the sample
file. Otherwise, the text
information such as version
number and the copyright
information that Filr adds might
overlap your custom branded
image.

Branding and Changing the User Interface 17
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File Name and
format

File Size

Sample File Format

Description

console_header.
png

205 x 48
Pixels

(")Filr World

To view the console header
image:

¢ On Windows: Right-click

E and then click Open
Filr console.

¢ On Mac: Click Eh and
then click Open Filr
Console.

NOTE: Ensure that your
custom branded image is of
the same size as the sample
file. Otherwise, the Desktop
Console text that Filr adds
might overlap your custom
branded image.

login_header.png

400 x 56
Pixels

Filr World

To view the login header
image:
¢ On Windows: Right-click

E and then click Login.

¢ On Mac: Click Eh and
then click Login.

FilrBranding.xml

NA

<?xm version="1.0" ?>
<Fi | r Brandi ng>

<ConpanyNanme>Conpany Nane</
ConpanyNane>

<About Fi | r Col or >Font _Col or _i n_hexa
deci nal _f or mat </ About Fi | r Col or >

<About Fi | r BgCol or >backgr ound_Col or

_in_hexadeci mal _f or mat </
About Fi | r BgCol or >

</ Fi | r Brandi ng>

Create an XML file using the
sample file format.

The company name that you
specify in this file replaces all
the instances where company
name is displayed in the
desktop application. For
example, in the About
Company Name - Filr option
that appears when you right-

click E on Windows or click
Eh on Mac.

The font color and the
background color that you
specify is applied on all the
text information such as Filr
version and copyright
information. You must specify
the color only in hexadecimal
format. For example:
#17202A.

Branding and Changing the User Interface
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Braltn;jing Mobile Apps (Advanced-Edition License
Only

As the built-in Port 8443 administrator, you can brand your Filr mobile apps to match your
organization’s brand.

IMPORTANT: Direct Port 8443 administrators do not have rights to administer branding.

+ “Android Ul Branding” on page 19
+ “iOS Ul Branding” on page 25
+ “Windows Phone Branding” on page 33

Android Ul Branding

To custom brand the Android Filr app, you must first create a folder on your system that will be used
to hold the resources used for custom branding. We will refer to this as the andr oi d- br andi ng folder
in the rest of this document.

You can customize the colors and the images that Android uses to customize the filr app. Let’s deal
with the images first and then the colors.

+ “Customizing Images for Android Branding” on page 19

¢ “Customizing Colors for Android Branding” on page 21

+ “Android Image Examples” on page 22

+ “Android Color Examples” on page 23

+ “Downloading Example Files” on page 25

Customizing Images for Android Branding

+ “About Image Density” on page 19
+ “Creating and Naming the Images” on page 20

About Image Density

Because Android runs on devices with a wide variety of screen densities, you should always provide
bitmap resources tailored to each of the generalized density buckets: low, medium, high and extra-
high density. This will help in achieving good graphical quality and performance on all screen
densities. If for some reason, you can'’t provide images for all of the density buckets, then you must
provide at least one image matching the XXXHDPI/XXHDPI/XHDPI scale factor. The higher
resolution image, the better the display quality.

First start with a base image and then generate the images for each density using the following scale
table. Remember in Android, 1dp (device independent) is equal to 160 pixels.

Branding and Changing the User Interface 19
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Density Bucket Name Scale Factor Pixels

LDPI 0.75 160 x 0.75 = 120 pixels
MDPI 1.0 160 x 1 = 160 pixels
HDPI 15 160 x 1.5 = 240 pixels
XHDPI 2.0 160 x 2 = 320 pixels
XXHDPI 3.0 160 x 3 = 480 pixels
XXXHDPI 4.0 160 x 4 = 640 pixels

For example, if you create a 75x75 image for LDPI then you need to create the following images to
match other densities.

Density Bucket Name Density Scale Create Image
LDPI 0.75 — Base Image 0.75x0.75
MDPI 1.0- 100 100 x 100
HDPI 1.5- (100 x 1.5) - 150 150 x 150
XHDPI 2.0-(150x 2) - 200 200 x 200
XXHDPI 4.0 — (200 x 3) - 600 600 x 600
XXXHDPI HDPI6.0 — (600 x 4) - 2400 2400 x 2400

Creating and Naming the Images

Filr Android-app customizing involves the following branding images.

Table 4-2 Android Image Names and Default Sizes

Image Name Location Where Displayed Recommended Dimension
Ratio*
i c_l auncher. png This image is shown on the passcode lock 144 x 144 pixels
screen.
| ogi n_header . png This image is shown on the login screen. 775 x 144 pixels
mai n_page_| ogo. png This image is shown next to the up button. 475 x 96 pixels

* Images that conform with the ratios shown will render without distortion in the locations indicated. For
example, ani c_| auncher. png image that is 288 X 288 pixels will render without distortion.

Create the following folder/folders in the andr oi d- br andi ng folder that you created on your system.
You don’t have to create all folders matching different scaling factors. You can create one generic
folder called “drawable” and place higher resolution images in this folder. This higher resolution image
will be scaled dynamically by Android to make it look good on different Android devices. Providing a
lower resolution image will not yield satisfactory results.
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Table 4-3

Folder Name Description

drawable-ldpi Place all lower resolution images here

drawable-mdpi Place all base resolution images here

drawable-hdpi Place all high resolution images here

drawable-xhdpi Place all extra high resolution images here
drawable-xxhdpi Place all extra extra high resolution images here
drawable-xxxhdpi Place all extra extra extra high resolution images here
drawable Place the highest possible resolution images here.

Images placed here may not be required to be placed
in other folders. Images placed in this folder are
dynamically scaled by Android to make them look
good on various devices.

Customizing Colors for Android Branding
To customize the colors in Filr's Android mobile app, create a file called col ors. xm in the andr oi d-

br andi ng folder and add the colors with your chosen values. Filr’s Android app supports customizing
the following colors.

Table 4-4 Android Color Tags

Color Name Where it is shown
main_header_start These two colors are used for creating a gradient
) shade that is applied to the header bar. This change is
main_header_end visible only in the What's New section.
view_header_start These two colors are used for creating a gradient
) shade that is applied to the header bar. This change is
view_header_end visible throughout the Ul, except in the What’s New
section and on the main page where the tabs are
shown.
list_header_text This color is used for list-header text. It is visible in the

Share-action dialogs.
form_background This color is used in the Add Comments dialog.

property_value_text This color is used to display links and text.

Example content of the col ors. xni file:

<br andi ng>
<mei n_header _st art >#75717c</ mai n_header _start>
<mai n_header _end>#4D2525</ mai n_header _end>
<vi ew_header _st art >#9CCCDC</ vi ew_header _start >
<vi ew_header _end>#519217</vi ew_header _end>
<l'i st _header _t ext >#7EB5CL</ | i st _header _t ext >
<f or m_backgr ound>#F7&G4</ f or m backgr ound>
<property_val ue_t ext >#246d9g</ property_val ue_t ext >
</ br andi ng>
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NOTE: The custom-branding-resource subsystem is very stringent in interpreting hex codes. You
must specify the fully valid color hex code including the pound sign (#). If you miss specifying this
sign, then the color value is ignored and default color hex code is used. The supported formats are
#FFFFFF and #FFFFFFFF

Select the col ors. xn file and the dr awabl e. . . folders in your andr oi d- br andi ng equivalent folder
and create a zip archive. Store the zip archive somewhere on your system for use when configuring
the branding on the Android client.

To apply the branding you have created, see “Using the Mobile App Branding dialog” in the Filr 3.2:
Administrative Ul Reference.

Android Image Examples

Fowered by Digital Ardines

Filr World

Ao Evuldngd + W BF AR JdoRERE

* main_page_logo.png

22 Branding and Changing the User Interface



* iic_launcher.png

Android Color Examples
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Downloading Example Files

You can download an example set of Android Branding Files here.

IOS Ul Branding

To brand your iOS mobile devices, you create a .zip file that includes branding images and color
specifications, as described in the following sections.

*

*

*

*

*

“Tips and Caveats” on page 25

“Downloading iOS Example Files” on page 26
“iOS Branding File Details” on page 26

“iOS Color Customization Details” on page 30
“Creating an iOS Branding .zip File” on page 33

Tips and Caveats

The following points apply to iOS branding files:

*

Inclusion of any of the customized branding files is optional.

The iOS app will work fine whether or not they are found in the .zip file.

If a file is in the zip file it will be used.

Otherwise, the default Micro Focus branding displays.

Files must be named exactly as specified or iOS applications will not find them.

Allimage files should be set to 72 PPI (pixels per inch). Increasing the resolution beyond this can

negatively affect app performance.
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../../resources/android-branding-sample.zip

Downloading iOS Example Files

You can download an example set of iOS Branding Files here.

1I0S Branding File Details

+ “Overview of iOS Branding Files” on page 26

+ “Example: PIN Code and Document Picker Extension” on page 26

+ “Example: Account Settings Dialogs and the Login Dialog for iPhone” on page 27
+ “Example: iPad Login Dialog” on page 28

+ “Example: Home Selection View” on page 29

Overview of iOS Branding Files

Table 4-5 iOS Branding File Summary

Image Names Where Used Dimensions in Pixels

¢ Filr_40_ios. png PIN/Passcode and Document * 40X 40
Picker dialogs

¢ Filr_40_i os@x. png* ¢ 80X 80

¢ Filr_40_i os@x. png * * 120 X120
¢ Filr_header. png Account Settings dialogs and Login ¢ 300X72

¢ Filr_header @x. png * dialog for iPhone * 600 X 144
¢ Filr_header @x. png * + 900 X 216
¢ Filr_icon_login.png iPad Login dialog + 600 X 233
¢ Filr_icon_| ogi n@x. png * + 1200 X 466
¢ Filr_icon_| ogi n@x. png * + 1800 X 699
¢ Filr_signature. png Home Selection View ¢ 248 X 60

¢ Filr_signature@x.png* * 496 X 120
¢ Filr_signature@x.png* ¢ 640 X 155

* The files named . . . @x and . . . @x support optimal image scaling on multiple devices.

Although it is not required that you create scaled images, Micro Focus recommends that you follow the image
guidelines in the iOS Human Interface Guidelines published by Apple (https://developer.apple.com/ios/human-
interface-guidelines/graphics/image-size-and-resolution/).

The iOS sample files include examples of each file in the sizes indicated.

Example: PIN Code and Document Picker Extension

To brand the PIN Code and Document Picker Extension dialogs, create a Fi | r _40_i os. png file and
include it in the .zip file.
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Figure 4-1 Filr_40_ios.png Example

PIN Code and Document Picker Dialogs

Filr_40_ios.png
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Cancel Passcode
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Example: Account Settings Dialogs and the Login Dialog for iPhone

To brand the account settings dialog and the login dialog for iPhone devices, create a
filr_header. png and include it in the zip file.
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Figure 4-2 filr_header.png Example

Account Settings Dialogs
and
iPhone Login Dialog

filr_header.png

Account Settings iPhone Login Dialog
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Example: iPad Login Dialog

To brand the login dialog on iPad devices, create a Fi | r _i con_| ogi n. png file and include it in the
.zip file.
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Figure 4-3 Filr_icon_login.png Example

iPad Login Dialog

Filr_icon_login.png

—

Filr
World

Example: Home Selection View

For branding the Home Selection View, create a Fi | r _si gnat ur e. png file and include it in the .zip

file.
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Figure 4-4 Filr_signature.png Example

iPad Home View

Filr_signature.png

iOS Color Customization Details

The FilrBranding.xml file defines the colors displayed. Examples are included after the XML sample
below.

<?xm version="1.0"7?>
<Fi | r Brandi ng>
<Vi ewHeader Col or >#0d467f </ Vi ewHeader Col or >
<SubheadCol or >#c1d7ec</ SubheadCol or >
<Li st HeadText Col or >#0d467f </ Li st HeadText Col or >
<For mHeadText Col or >#0d467f </ For nHeadText Col or >
<For mBackgr oundCol or >#d7e6f 5</ For nBackgr oundCol or >
<Hi ghl i ght Bl endSt art Col or >#af d4f a</ Hi ghl i ght Bl endSt art Col or >
<Hi ghl i ght Bl endEndCol or >#3d86ce</ H ghl i ght Bl endEndCol or >
<St at usBar Text Col or >l i ght </ St at usBar Text Col or >
</ Fi | r Brandi ng>

Hex values are valid as well as the colors defined in the iOS UlColor class such as red, blue, yellow,
etc. They can be defined in upper, lower or mixed case.

An example would be <ViewHeaderColor>green</ViewHeaderColor>.
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There are two valid values for StatusBarTextColor: “dark” and “light”.

The following are examples.

Figure 4-5 Example 1

StatusBarTexCalor = dark

& Shared with Me  Info

| WordDoc1.dacx ViewHeaderColor
nared with vie
12.1 KB
Glen Christensen
@’ Created: Apr 18, 2016, 3:20 PM
(M
/ Shared By FormBackgroundColor
».  Glen Christensen
ListHeadTextColor @ Shared on: Apr 21, 2016, 1:48 PM
. Access: Editor
Figure 4-6 Example 2
SubheadColor ViewHeaderColor

Shared with Me

Q
127 on 9443.pcapng
D Shared by 2.1 Admin @
on May 4, 2016
- WordDoc15.docx
M Shared by Glen Christensen @

on Apr 21, 2016
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Figure 4-7 Example 3
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Creating an iOS Branding .zip File

To apply custom branding to the iOS client, you create the image files for the dialogs you want to
brand and define banner and other colors, as follows:
1 Create . png files for the dialogs that you want to brand.

Example files are contained in the downloadable i Cs- br andi ng- sanpl e. zi p (../../resources/
ios-branding-sample.zip) file.

To support optimal image scaling on multiple devices, Micro Focus recommends that you follow
the imaging naming conventions outlined in the iOS Human Interface Guidelines published by
Apple (https://developer.apple.com/ios/human-interface-guidelines/graphics/image-size-and-
resolution/).

2 Define the colors you want to use in banners and so on, by creating a Fi | r Brandi ng. xni file.
3 Compress the files that you have created into an arbitrarily named . zi p file.

4 Upload the . zi p file using the instructions in “Branding the Mobile Apps (Advanced-Edition
License Only)” in the Filr 3.2: Administrative Ul Reference.

Windows Phone Branding

You can download a sample Windows app branding .zip file here.

+ “Settable Colors” on page 33

+ “A Sample FilrBranding.xml File” on page 34

+ “Customizable Images” on page 34

+ “Assembling and Uploading the Zip File” on page 34

Settable Colors

The colors displayed in the Filr Windows Mobile Client can be customized using the following
properties defined in the Fi | r Brandi ng. xm file.

+ LoginFontColor

+ ApplicationBackgroundColor

+ ApplicationFontColor

+ AppbarBackgroundColor

+ AppbarForegroundColor

¢ StatusBarBackgroundColor

¢ StatusBarForegroundColor

+ DetailsPageBackgroundColor

¢ SearchlconColor

+ HamburgerMenuColor

+ ApplicationTitle
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A Sample FilrBranding.xml File

<br andi ng>
<Logi nFont Col or >#000000</ Logi nFont Col or >
<Appl i cat i onBackgr oundCol or >#FFD700</ Appl i cat i onBackgr oundCol or >
<Appl i cat i onFont Col or >#FFFFFF</ Appl i cat i onFont Col or >
<Appbar Backgr oundCol or >#FF6347</ Appbar Backgr oundCol or >
<Appbar For egr oundCol or >#FFFFFF</ Appbar For egr oundCol or >
<St at usBar Backgr oundCol or >#FF7F50</ St at usBar Backgr oundCol or >
<St at usBar For egr oundCol or >#FFFFFF</ St at usBar For egr oundCol or >
<Det ai | sPageBackgr oundCol or >#FF4500</ Det ai | sPageBackgr oundCol or >
<Sear chl conCol or >#FF4500</ Sear chl conCol or >
<Harbur ger MenuCol or >#FF4500</ Hanbur ger MenuCol or >
<ApplicationTitle>My Filr</ApplicationTitle>

</ brandi ng>

Customizable Images
You can customze two images that are located on the login page.
The two image must be named as follows:

+ Logi nbackground. png (for login page background)
+ Logi nheader . png (for login page header)

Assembling and Uploading the Zip File

You can download a sample Windows app branding .zip file here.

After creating your own Windows branding components, do the following:
1. Zip these three files together and then upload to the server.

The branding changes are applied on the background thread.
2. In some cases the branding is not applied properly due to a resource contention.
Stopping and restarting the app should resolve the issues.

3. After creating your .zip file, see “Using the Mobile App Branding dialog” in the Filr 3.2:
Administrative Ul Reference.

Branding the Web User Interface

See “Branding the Web Client” in the Filr 3.2: Administrative Ul Reference.
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Changing the Title of the People Page
Filr enables you to modify the name of the People page. (This is an alternate way of viewing users in
your Filr system.) This name is displayed when navigating the Workspace tree (as described in

“Navigating the Workspace Tree” in the Filr 3.2: Maintenance Best Practices Guide) and when
performing a search.

1 Click the People icon m in the masthead.

2 Click the Configure icon @ next to the folder name, then click Rename Workspace.

3 In the New Name field, specify a new name for the workspace, then click OK.
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5 Desktop Application Maintenance

+ “Client Management Software and the Filr Desktop Applications” on page 37
+ “Controlling File Downloads by the Filr Desktop Applications” on page 40

+ “Desktop Application Installation Files—Location” on page 42

+ “Desktop Application Software Management” on page 42

+ “Enabling Desktop Access for Users” on page 44

+ “Synchronization-Traffic Management” on page 44

Client Management Software and the Filr Desktop
Applications

You can manage the Filr desktop application on users’ workstations with client management software
such as Micro Focus ZENworks.

When following the instructions in this section, you must use the . nsi file, which is bundled in the
Novel | Fi | r Aut oUpdat e. t gz file, and is available on the Filr software download site.

If you use the . nsi file to distribute the Filr desktop application to user workstations, you need to
install the following items to each user workstation, independent of the Filr software:

+ Microsoft .NET Framework 4.5 (Applies to 64-bit Windows and Mac workstations.)
You can download Microsoft .NET Framework 4.5 from the Microsoft .NET Downloads page
(http://www.microsoft.com/net/downloads).

+ Microsoft Visual C++ 2013 Redistributable Package (Applies to all workstations)

You can download the redistributable package from the Microsoft Download Center (https://
www.microsoft.com/en-us/download/details.aspx?id=40784).

NOTE: The ability to manage the Filr desktop application is available only with Filr desktop 1.0.2 and
later.

You can customize the installation and control whether Windows Explorer is restarted.

Customizing the Installation for the Filr Desktop Application

You can customize the installation process of the Filr desktop application for your organization in the
following ways:

+ Configure default values for each installation option of the Filr desktop application. (Users can
change these default values when configuring the Filr desktop application.)

+ Auto-configure all values for each installation option of the Filr desktop application. (Users
specify only their user name and password when configuring the Filr desktop application; users
cannot change the default values during initial configuration.)
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+ Disallow users from modifying configuration options in the Filr desktop application. (Users
cannot change the default values during initial configuration, and cannot modify the values via
the Filr console after initial configuration.)

NOTE: This does not prevent users from manually modifying configuration settings in the
registry or file system.

The following sections describe how to make these customizations.

Configuring Default Values

You can configure the default values for each installation option of the Filr desktop application. Users
can change these default values when configuring the Filr desktop application.

You accomplish this on Windows by creating registry values, and on Mac by adding properties to the
application’s | nf o. pl i st file.

1 Windows: Access the following location where you will create registry values:

\'\ HKLM Sof t war e\ Novel [\ Fi | r

Mac: Access the | nfo. pli st file where you will add properties. This file is usually in the
following location:

/ Applications/Mcro Focus Filr/Contents/Info.plist

2 Create Windows registry values and add properties to the I nf o. pl i st file for the values for
which you want to configure defaults.

The following table displays the available options for configuring default values.

Table 5-1 Default Value Configuration Options

Windows Value Type Mac Property Value Type Supports Env Default Value
Registry Value Name Variables
Name
Default Server REG_SZ FilrDefaultServer string No https://
URL URL
Default REG_SZ FilrDefaultUsern string Yes %USERNAME%
Username ame

or

$USER
Default Account REG_SZ FilrDefaultAccou string No Hostname in
Name ntName server URL
Default REG_SZ (“true” FilrDefaultReme <true/> or <false/ No false
Remember or “false”) mberPassword >
Password
Default Sync Dir REG_SZ FilrDefaultSyncD string Yes %USERNAME%

ir \Filr

or

$USER\Filr
Default Start On  REG_SZ (“true” FilrDefaultStartO <true/> or <false/ No true
Login or “false”) nLogin >
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Enabling Auto-Configuration

After you have configured default values for the Filr desktop application installation, you can enable
auto-configuration. When auto-configuration is enabled, users cannot change the default values
during initial configuration. (Users specify only their user name and password when configuring the
Filr desktop application.)

You accomplish this on Windows by creating registry values, and on Mac by adding properties to the
application’s I nf o. pl i st file.
1 Windows: Access the following location where you will create registry values:
\'\ HKLM Sof t war e\ Novel I\ Filr

Mac: Access the I nfo. pl i st file where you will add properties. This file is usually in the
following location:

/ Applications/Mcro Focus Filr/Contents/Info.plist

2 Create Windows registry values and add properties to the | nf 0. pl i st file for the values for
which you want to configure defaults.

The following table displays the available options for auto-configuration.

Table 5-2 Auto-Configuration Options

Windows Value Type Mac Property Value Type Supports Env  Default Value
Registry Value Name Variables
Name
Auto Configure  REG_SZ (“true” FilrAutoConfigur <true/> or <false/ No false
or “false”) e >

Disallowing User Configuration

You can disallow users from modifying configuration options in the Filr desktop application. This
means that users cannot change the default values during initial configuration, and they cannot
modify the values via the Filr console after initial configuration.

NOTE: This does not prevent users from manually modifying configuration settings in the registry or
file system.

You accomplish this on Windows by creating registry values, and on Mac by adding properties to the
application’s I nf o. pl i st file.
1 Windows: Access the following location where you will create registry values:
\'\ HKLM Sof t war e\ Novel I\ Filr

Mac: Access the I nfo. pl i st file where you will add properties. This file is usually in the
following location:

/ Applications/Mcro Focus Filr/Contents/Info.plist

2 Create Windows registry values and add properties to the | nf 0. pl i st file for the values for
which you want to configure defaults.

The following table displays the available options for disallowing user configuration.
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Table 5-3 Disallow User Configuration Options

Windows Value Type Mac Property Value Type Supports Env Default Value
Registry Value Name Variables

Name

Allow User REG_SZ (“true” FilrAllowUserCo <true/> or <false/ No true
Configuration or “false”) nfiguration >

Modifying the Filr Desktop Configuration

If you have configured the Filr desktop application with auto-configuration (as described in “Enabling
Auto-Configuration” on page 39), you can modify the configuration settings:
1 Change the options in the registry or . pl i st file, then restart the Filr desktop application.

When the Filr desktop application starts, it detects that the default settings have changed and
applies the new settings.

NOTE: The one exception is that the synchronization directory cannot be changed after the Filr
desktop application has been configured.

Controlling Windows Explorer Restart

The Filr desktop application for Windows includes overlay icons that do not appear until Windows
Explorer is restarted. Prior to the Filr 1.0.2 desktop application, the Windows . nsi always restarted
Windows Explorer during the installation (except when using the No Ul option). Because restarting
Explorer might not always be desirable, the Filr 1.0.2 desktop application allows you to override the
default.

The Windows installer supports four basic user interface levels for installing M8l files:
+ No Ul (“msiexec /gn”)

Windows Explorer is never restarted when using this option.
+ Basic Ul (“msiexec /qb”)
+ Reduced Ul (“msiexec /qr”)

+ Full Ul (“msiexec /qf’ or simply “msiexec”, since this is the default)

For example, use the following command to install the M5l with basic Ul and without restarting
Windows Explorer:

nei exec /qgb /i M croFocusFilr-version. nsi RESTARTEXPLORER=NnO

Controlling File Downloads by the Filr Desktop
Applications

Path to Configuration Page: Filr Administration Console > System > Desktop Application >
Application Whitelist/Blacklist
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Why File-Download Control Is Important
Filr can download large numbers of online files when workstation-based applications, such as

antivirus scanners and backup software, request access to them. Downloading the files stored in Net
Folders can quickly fill up a local disk.

How File-Download Control Works

To let you control application-driven downloads and prevent Filr from filling up local disks, Filr
provides the Application Whitelist/Blacklist dialog and the following options:

NOTE: for more information regarding the user experience, see “Preventing Application-Driven
Downloads From Filling Up the Local Disk” in the Desktop Guide for Windows and the Desktop Guide
for Mac.

Always Blacklist Macintosh Antivirus Applications

Antivirus software running on Mac workstations downloads files automatically. Therefore, you should
always include Mac antivirus applications in the Blacklist.

Managing File Downloading

If your organization deploys the Filr desktop application, we recommend that you identify a file-
download control strategy by doing the following:

1 Log in to the Filr administration console and navigate to System > Desktop Application >
Application Whitelist/Blacklist.

2 Review the list of applications that are blocked by default for the desktop platforms (Windows
and Mac) that your organization uses.

3 If you want to only block certain applications from downloading files through Filr, ensure that the
applications are listed in the appropriate Windows and Mac blacklists.

For example, if you know that a specific set of company-approved virus scanners are the only
applications that could trigger mass downloads, then simply ensure that those scanners are in
your blacklists.

Download requests from applications that are listed, such as virus scanners, will trigger a system
alert to users.

If you add entries to the blacklists, use the existing entries as a pattern. Windows and Mac have
unigue requirements for identifying the applications to be blocked.

4 If you want to control exactly which applications can download files through Filr, you should
create a whitelist.

For example, if your users are only authorized to work with the applications in an office suite,
then you should create a whitelist with only those applications listed.

Applications that are not listed, such as virus scanners, will trigger a system alert to users.
Attempts to open any online-only files by unauthorized applications will fail.

As you create a whitelist, use the existing blacklist entries as a pattern. Windows and Mac have
unigue requirements for identifying the applications to be allowed.
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5 If you want a flexible approach that allows downloading by specified applications, blocks
downloading by other applications, and lets users deny or approve download requests by
unlisted applications, then deploy both a whitelist and a blacklist.

6 Periodically review and update your file-download strategy. Make sure that new antivirus and
backup software is included. Consult with users about applications that they have allowed or
blocked, and consider adding these to your lists as applicable.

Desktop Application Installation Files—Location

Although you can specify that the clients be downloaded from the local appliance, Micro Focus
recommends hosting the Filr desktop applications on a separate web server, as documented in
Chapter 7, “Hosting Desktop Application Installation Files on a Separate Server,” on page 49.

For example, if the server host name is myserver.example.com, then a URL similar to the following
would need to be set in the Web Administration Console (port 8443). Click Desktop Application in the
left frame.

Configure Desktop Application (7]

Allow desktop applications to:

[¥] Access Filr
[¥! Cache the users password
[ Be deployed
Deploy files contained locally
@ Deploy files accessed va a URL to another location

[ hittpe iy server.example comy desktopap/navelifil

Desktop synchronization

Synchronize every: | 15 Minutes

Maximum file size that can be synchronized: | 50 ME

The Filr desktop applications can also be hosted on Filr appliances, as documented in Chapter 7,
“Hosting Desktop Application Installation Files on a Separate Server,” on page 49, provided that the
appliances are not fronted by an L4 or L10 switch.

For more information on configuring the desktop applications, see “Desktop Access—Default
Settings” in the Filr 3.2: Administrative Ul Reference.

Desktop Application Software Management

You can update the Filr desktop application on users’ workstations by updating the application on the
Filr server or on a separate web server. You can also distribute the application using the . nsi file in
conjunction with client management software such as Micro Focus ZENworks. However, there are
certain dependencies that are not installed by default when using the . nsi file. These are described
in the following sections:
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Understanding Missing Dependencies Related to Updating
the Filr Desktop Application by Using the MSI File

If you use the . nsi file to distribute the Filr desktop application to user workstations (by using client
management software such as Micro Focus ZENworks), you need to install the following items to
each user workstation, independent of the Filr software:

+ Microsoft .NET Framework 4.5 (Applies to 64-bit Windows and Mac workstations.)
You can download Microsoft .NET Framework 4.5 from the Microsoft .NET Downloads page
(http://www.microsoft.com/net/downloads).

+ Microsoft Visual C++ 2013 Redistributable Package (Applies to all workstations)

You can download the redistributable package from the Microsoft Download Center (https://
www.microsoft.com/en-us/download/details.aspx?id=40784).

Updating the Filr Desktop Application on the Filr Appliance

If you have configured your Filr system to deploy the Filr desktop application (as described in
“Enabling Desktop Access for Users” on page 44), or if you have configured a separate web server to
deploy the Filr desktop application (as described in Chapter 7, “Hosting Desktop Application
Installation Files on a Separate Server,” on page 49), you can replace the Filr desktop application
download files on the Filr back end so that users are prompted to update the Filr desktop application
on their individual workstations.

The files to use for updating the Filr desktop application are the same for all versions of Windows.
To download the Filr desktop application:

1 Before downloading the new version of the Filr desktop application, you need to preserve your
existing Filr desktop installation. This will allow you to roll back to the older version if the need
arises.

To preserve your existing installation of the Filr desktop application, rename the existing directory
on the server so that the old files are not overwritten when the new version is downloaded:

la Change to the directory where the files are being stored. For example:

cd /opt/novel l/filr/apache-tontat/webapps/ deskt opapp/

This is the default location if the Filr desktop application is installed on the Filr server.
1b Rename the novel | filr directory to novel | fil r. bak. For example:

nv novel I filr novel lfilr.bak

1c (Optional) If you need to roll back to the older version of the Filr desktop application, you
can do so by deleting the new novel | fi | r directory and renaming the novel | filr. bak
directory to novel I filr.

2 Download and extract the Novel | Fi | r Aut oUpdat e. t gz file onto your Filr server or separate web
server.

tar xvzf Novel | FilrAutoUpdate.tgz
You can download the Novel | Fi | r Aut oUpdat e. t gz file from the Filr software download site.

If you are installing onto the Filr server, download and extract this file to the opt/ novel I /filr/
apache-t ontat / webapps/ deskt opapp/ directory.

cd /opt/novel l/filr/apache-tontat/webapps/ deskt opapp
This compressed file contains all of the files required for updating the Filr desktop application.
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3 Run the following commands on the extracted directory to appropriately modify the file
permissions:

chown - R www un: www novel | filr/
chmod -R g-w novel I filr/

chnod -R o-rwx novel [ filr/

Enabling Desktop Access for Users

Desktop access is not enabled by default.

The Filr desktop application lets users synchronize their Micro Focus Filr files with their personal
computers. You can enable this functionality for all users in the Filr system, or for individual users and
groups.

In addition to enabling or disabling this functionality for users, you can also make configuration
changes that affect the load that the Filr desktop application puts on your Filr system, as well as make
changes that ensure tighter security.

Users need to download, install, and configure the Filr desktop application on their personal
computers. For more information, see the Micro Focus Filr Desktop Application Guide for Windows
(http://www.novell.com/documentation/filr-3/filr-desktop/data/bookinfo.html) and the Micro Focus Filr
Desktop Application Guide for Mac (https://www.novell.com/documentation/filr-3/filr-desktop-mac/
data/bookinfo.html).

Synchronization-Traffic Management

The Filr desktop application can cause a large amount of traffic on the Filr servers. To prevent the Filr
desktop application synchronization process or the Filr site from becoming slow, you can distribute
the Filr desktop application traffic among dedicated Filr servers with your load balancer or reverse
proxy server.

For example, if you have a Filr installation with four servers, you could dedicate one server to handle
the Filr desktop application traffic and use the remaining three servers to serve the main Filr Web
application. This configuration prevents an unusual spike in the Filr desktop application traffic from
impacting the Filr site.

You can distribute the Filr desktop application traffic differently, depending on whether you want traffic
from all applications (not just the Filr desktop application) that are accessing Filr to be handled in the
same way, or whether you want the Filr desktop application traffic to be handled independently from
each other and from other applications that are accessing Filr.

Distributing Filr Desktop Application Traffic Separately from
Other Applications

You can configure your load balancer or reverse proxy server to distribute Filr desktop application
synchronization traffic among multiple Filr servers. Filr desktop application traffic is independent of
traffic from other applications that are accessing Filr.
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NOTE: Your load balancer or reverse proxy server must be able to make routing decisions based on
the request headers.

1 Configure your load balancer or reverse proxy server to use the user agent request header. For
the Filr desktop application, the request header begins with Novel | Fi | r Deskt op. For example:
User-Agent: Novel | FilrDesktop/1.0 (Wndows NT 6.1; Python/2.7.0; en_US) suds/
0. 4.

For specific information on how to configure the load balancer or reverse proxy server, see “Load
Balancer and Reverse Proxy Server Configuration” on page 45.

Distributing Filr Desktop Traffic in Conjunction with Other
Applications

You can configure your load balancer or reverse proxy server to distribute Filr desktop application
synchronization traffic (along with traffic coming from all other applications that use the Filr Web
service interface) among multiple Filr servers.

Examples of other applications that use the Filr Web service interface:

+ GroupWise client SOAP requests
+ All other SOAP requests from third-party applications

NOTE: Your load balancer or reverse proxy server must be able to make routing decisions based on
the HTTP URL path.

1 Configure your load balancer or reverse proxy server to send all HTTP requests for the Filr
desktop application (designated by the following paths / ssf/ ws/ Teami ngSer vi ceV1 and/ r est/
*) to one pool of Filr servers.

All other requests are sent to another pool of Filr servers.

For specific information on how to configure the load balancer or reverse proxy server, see “Load
Balancer and Reverse Proxy Server Configuration” on page 45.

Load Balancer and Reverse Proxy Server Configuration

To configure a reverse-proxy server for your Filr site, see “Reverse Proxy Configuration Settings” in
the Filr 3.2: Administrative Ul Reference.
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Helping Micro Focus Improve Filr

In order to improve the Filr product, it is critical that the Filr development team understands how
organizations are deploying Filr.

+ “Organizational Privacy Is Protected” on page 47
+ “How Micro Focus Collects Product Improvement Data” on page 47
+ “How Micro Focus Receives Product Improvement Data” on page 48

¢ “Submitting Your Product Improvement Ideas” on page 48

Organizational Privacy Is Protected

We do not collect information that can be used to identify specific organizations. Rather we collect the
following, depending on how you configure your system.

At a basic level (Tier 1), Filr collects the following information:

+ Product version
+ License type
+ Number of users

If you allow us to, we also collect basic information about the deployment size and configuration:

+ Number of files
+ Number of folders
+ And so on

You can view the information collected after the system has been running for 24 hours, by using the
View the information collected link in the Product Improvement dialog.

How Micro Focus Collects Product Improvement Data

The first time you log in to Filr, after changing the admin user’s password, a dialog displays that
explains the purpose of the Filr data collection system and lets you change the configuration.

The data collection process runs for the first time when a Filr appliance has been running for 24
hours. Thereafter, it runs weekly.

See “Product Improvement” in the Filr 3.2: Administrative Ul Reference.
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How Micro Focus Receives Product Improvement
Data

After the weekly data collection process concludes, the system creates a . j son data file and sends it
to ftp://product f eedback. novel I .com stats/filr.

If the FTP transfer is unsuccessful, the system attempts to send it again during the next weekly cycle.
No send attempts are made outside of the weekly cycles.

Data files are sent through a regular non-secure FTP connection. File contents are not encrypted
because no sensitive or identifying information is included.

Submitting Your Product Improvement ldeas

When you are logged in as an administrative user, you can access the Micro Focus Filr Ideas Portal
page from the Port 8443 Filr Administration Console by clicking your user name and selecting the
Ideas Portal link.

admin

& Administration Console
View Profile
Personal Preferences
Change Password

Help

deas Portal

Sign out

You can also view the ideas that others have submitted, add comments, and vote for your favorite
product-improvement ideas.
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Hosting Desktop Application Installation
Files on a Separate Server

By default, the Filr server is configured to deploy the Filr desktop application and to provide the auto-
update information. As a best practice to minimize load on the Filr server, we recommend that you set
up a separate web server and configure it to deploy the desktop application and provide the auto-
update information.
1 Set up a web server as a host for the Filr desktop application auto-update information.
This web server must be set up so that it does not require authentication.

2 Download and extract the Novel | Fi | r Aut oUpdat e. t gz file onto the web server. (You can
download the Novel | Fi | r Aut oUpdat e. t gz file from the Filr downloads page on the Micro Focus
Downloads site (https://download.novell.com).)

This compressed file contains all of the files required for installing the Filr desktop application.

For example, if you download this file to the Desktop, extracting the file results in the following
directories:

https://web_server _DNS or | P/filr/desktop/novellfilr/osx
https://web_server DNS or | P/filr/desktop/novellfilr/w ndows

3 (Optional) Ensure that you can access the files on your web server through one of the following
methods:

* From a browser
For example:

http://web_server_address/ deskt opap/ novel | filr/w ndows/x64/version.json

+* From a command line

For example, from the Web server, SSH to the Filr appliance and run the following
command:

#wget http://web_server_address/ deskt opapp/ novel | filr/w ndows/ x64/
version.json

4 Configure the Filr desktop application using the Port 8443 Administrative Console > System >
Desktop Application dialog.

In the Deploy files accessed via a URL to another location field, specify one of the following
URLs, depending on whether your web server is configured with secure HTTP:

https://web_server DNS or | P:8443/fil e_path/ deskt opapp/
http://web_server _DNS or | P: 8080/ fil e_pat h/ deskt opapp/
5 Click OK.
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8 KeyShield Integration with Filr

Use the information and instructions in the following sections to configure Filr to work with an existing
KeyShield installation.

*

*

“Prerequisites” on page 51

“(Conditional) Allowing the Authorization Connectors to Access the APl Key” on page 51
“Configuring Filr for KeyShield SSO Support” on page 51

“KeyShield Attribute Alias Support” on page 52

“Configuring Two-Factor Authentication” on page 53

“Downloading and Installing the KeyShield SSO SSL Certificate” on page 54

“Testing the KeyShield SSO Configuration” on page 54

Prerequisites

For Filr to work with an existing KeyShield installation, you must have the following already in place.

*

A KeyShield SSO server that is registered with DNS and provides single sign-on services to your
network users.

An API Key that is displayed in a defined API Authorization configuration.

One or more Authentication Connectors (defined on the KeyShield server) that are allowed to be
used with the API Key.

Administrative Access to the KeyShield server for obtaining the following:

+ The API Authorization Key associated with the KeyShield Connectors you are leveraging for
Filr

+ The SSL certificate, downloadable as a . CER file for importing into the Filr keystore.

(Conditional) Allowing the Authorization Connectors
to Access the API Key

Continuing in the General tab (accessed in the previous section), if access to the KeyShield SSO
APIs is restricted to users on specific connectors, ensure that the connectors that your Filr users will
be connecting through are listed by doing the following:

1

2

If the connectors your users will use are not listed, click the bar below the already-allowed
connectors.

Select the connectors for your users, then click OK.

Configuring Filr for KeyShield SSO Support

1

Open a new tab or a new browser session to access Filr on port 8443:
https://filr-ip-address-or-dns-nane: 8443
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For example htt ps: 192. 168. 30. 150: 8443

Having a new session will let you easily switch between the KeyShield administration console
and the Filr Administration console.

2 In the new browser session, log in to Filr as an administrator.
3 Click the admin link in the upper-right corner of the page, then click the Administration Console

icon

4 In the left frame, click KeyShield SSO.

5 In the KeyShield SSO Configuration dialog, click Enable KeyShield SSO.

6 Inthe KeyShield Server URL field, type the access URL for the KeyShield server:
https://ks-server-dns-nane_or _i p- address: ks-server-https-port/

7 Switch to the KeyShield browser-based console, toggle open the API Key, then select and copy
the key to your clipboard.

8 Switch to the Filr Administration panel and paste the API Key into the API Authorization field.

9 The HTTP Connection Timeout controls how long the Filr Appliance will wait for a response from
the KeyShield server before prompting users for their login credentials.

Micro Focus doesn’'t recommend changing this value unless the connection between the Filr
Appliance and the KeyShield SSO server doesn't facilitate a quick response. For example the
appliance and server are connected over a WAN.

10 In the Connector Names field, type the names of each KeyShield SSO connector that Filr users
will connect through.

11 Continue with the next section, “KeyShield Attribute Alias Support.”

KeyShield Attribute Alias Support

Filr lets administrators provision users from different LDAP sources, such as eDirectory and Active
Directory. It also allows for flexibility in specifying which LDAP attribute will be imported as the Filr
username.

In addition to Filr, organizations have email applications, RADIUS clients, and so on, that use different
LDAP attributes for their usernames.

KeyShield 6 includes support for Attribute Aliases. These let KeyShield match username validation
requests from each application with the LDAP attribute that the application uses for its usernames.

A Filr Example

1. Jane Smith logs in through KeyShield’'s SSO service using jsmith (her UID in LDAP) as her
Username.

2. Jane then launches Filr.

Unfortunately, the Filr administrator who configured the LDAP import, specified CN as the LDAP
username attribute and JaneSmith was impoted as Jane’s Filr username.

3. When Filr tries to authenticate Jane Smith, KeyShield doesn't find her as an authenticated user
and the attempt fails.

Jane is then prompted to log in to Filr.

4. To fix the mismatch of LDAP attributes, Jane’s KeyShield administrator adds x-filr = cnas an
Attribute Alias in Keyshield.
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6.

Jane’s Filr administrator adds x-fi |l r as the Username Attribute Alias in Filr.

The next time Jane launches Filr after signing in through KeyShield’ SSO service, KeyShield
verifies to Filr that JaneSmith is authenticated and no additional login is required.

Configuring Attribute Alias Support

1

3

In Keyshield, specify the appropriate Attribute Alias for each Authentication Connector.

For example, if your Filr deployment uses the CN attribute as the username for an eDirectory
server that is defined as an Authentication Connector in KeyShield, then in the Attribute Alias
field in the connector configuration, you would specify

x-filr =c¢n

This means that for this Authentication Connector, when authentication verification requests
arrive with the Attribute Alias x-fi | r, KeyShield needs to request a match in the CN attributes in
the targeted eDirectory Authentication Connector.

By default, the Filr 2.0 KeyShield SSO Configuration dialog, the Username Attribute Alias is set
tox-filr.

We strongly recommend that you not change this value. However, if you do, be sure that the
name is changed in each KeyShield Authentication Connector configuration as well.

Continue with “Configuring Two-Factor Authentication.”

Configuring Two-Factor Authentication

KeyShield 6.1 adds the ability to require a hardware token in addition to usernames and passwords
for LDAP users seeking access through a web browser or WebDAV.

NOTE: Two-factor authentication doesn't apply to desktop or mobile device applications.

Filr 2.0 supports KeyShield’s two-factor authentication capability through two new options in the
KeyShield SSO Configuration dialog:

*

Require Hardware Token: Requires a physical token, such as an access card, for access to
Filr.

You can also specify the error messages that you want displayed when the required token is
either not presented or not recognized by KeyShield for web browser or WebDAV access.
Allow Username/Password based Fallback Authentication (non-SSO) for LDAP Users:

Allows authentication by entering a username and password as an alternative to the hardware
token.

Use this option if you want users to be able to effectively bypass the hardware token requirement
by typing in their username and password.

If you want to configure two-factor authentication for your KeyShield 6.1 SSO service, select the
options and specify the text accordingly.

Click Test Connection.

Because the Filr appliance doesn’t yet have the KeyShield SSO SSL certificate in its keystore,
the test fails.

Continue with “Downloading and Installing the KeyShield SSO SSL Certificate” on page 54

KeyShield Integration with Filr 53



54

Downloading and Installing the KeyShield SSO SSL
Certificate

1

o 01~ W N

~

10
11
12
13

Open a third browser session and access the Filr appliance on port 9443:
https://filr-ip-address-or-dns-nane: 9443

For example htt ps: 192. 168. 30. 150: 9443

Log in as vaadmi n.

Switch to the KeyShield browser-based console and under General/Web Interface, click Edit.
Click the Download button for the HTTPS Keystore.

Save the Keyshi el d. cer file on the workstation running the browser.

Switch to the browser session opened in Step 1 on page 54 and click the Appliance
Configuration icon.

Click the Digital Certificates icon.
Click File > Import > Trusted Certificate.

Click Browse, then browse to the location where you saved the Keyshi el d. cer file and click
Open.

Click OK to import the certificate file.
Acknowledge the message about restarting the appliance by clicking OK.
Click the back arrow in the browser, then select Reboot.

After the system restarts, continue with the next section, Testing the KeyShield SSO
Configuration.

Testing the KeyShield SSO Configuration

1
2

3

Switch back to the Filr administration console (port 8443).

Click Test Connection.

The test should succeed.

Click OK to finalize the configuration and complete the Keyshield SSO integration.
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Using Multi-Factor Advanced
Authentication with Filr

Filr 3.2 introduces Advanced Authentication support for LDAP users. An LDAP user is prompted for
additional authentication steps in addition to the typical username and password authentication to log
in to Filr provided the Filr administrator has enabled multi-factor authentication on the Filr server.

Non-LDAP users are prompted only for the username and password to log into Filr.

Advanced Authentication is a multi-factor authentication solution that enables you to protect your
sensitive data by using a more advanced way of authentication, in addition to the typical username
and password authentication. This additional layer of security helps to ensure the identity of a user
and reduce the risk of unauthorized access to Filr.

Advanced Authentication provides a single authentication framework that ensures secure access to
all your devices with minimal administration. With Advanced Authentication, you can use different
types of authenticators such as a Security Question, a PIN, and an OTP to authenticate on diverse
platforms.

Authentication comprises the following three factors:

+ Something that you know such as password, PIN, and security questions.
+ Something that you have such as smartcard, token, and mobile phone.
+ Something that you are such as biometrics (fingerprint or iris).
You can achieve multi-factor or strong authentication by using any two factors out of this list. For

example, multi-factor authentication can include the combination of a password and a token or a
smartcard and a fingerprint.

For more information about using the NetlQ Advanced Authentication Framework and the supported
authentication providers, see the NetlQ Advanced Authentication Framework (https://www.netig.com/
documentation/advanced-authentication-framework/) documentation website.

Prerequisites for Using Advanced Authentication with
Filr

O AFilr appliance is installed and configured with an advanced-edition license.

O A NetlQ Advanced Authentication Framework 5.5 or later appliance is installed and configured.
See Advanced Authentication Administration Guide on the documentation website.

O All the Filr clients must be up-to-date with the latest patch installed before enabling multi-factor
authentication.

When multi-factor authentication is enabled on a Filr server, users with older versions of the Filr
client cannot log into the server and therefore will not receive any system alerts to update the
client.

O Avalid SSL certificate that is signed by a well-known certificate authority (CA). Self-signed
certificates are not supported.
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Configuring OAuth2 Event in Advanced
Authentication Server Appliance

In the Advanced Authentication Administration Portal, you can configure and manage various

authentication settings such as methods, events, and so on. You can also configure various policies
that are required for authentication. For more information about configuring Advanced Authentication
Server Appliance, see Advanced Authentication Administration Guide on the documentation website.

To configure:

1 Log into the Advanced Authentication Administrative Portal as follows:

htt ps://advanced_aut henti cati on_dns_nane_or | P_Address/adm n

2 Add an Active Directory or eDirectory repository where your Filr users are stored.

3 Configure an authentication method for Advanced Authentication.

NOTE: The following methods have been tested with Filr.

*

*

*

*

*

*

*

LDAP Password
Password

SMS OTP

Email OTP
Security Questions
Smartphone
TOTP

Other authentication methods that NetlQ Advanced Authentication with OAuth2 event supports
would also work, but they have not been explicitly tested.

4 Create an authentication chain that is a combination of all the authentication methods that users
must pass for successful authentication.

5 Configure OAuth2 type event.

5a
5b
5c
5d

5e
5f

Specify a name for the event.
Enable the event by changing Is enabled to ON.
Select the OAuth2 event type.The client ID and client secret are generated automatically.

Note down the client ID and client secret values. You must specify these values in the NetlQ
Advanced Authentication page of the Filr Administration Console (Port 8443 Filr Admin
Console > > System > NetlQ Advanced Authentication). You can copy the values and
paste them in the Filr admin Console. See NetlQ Advanced Authentication Configuration in
the Filr 3.2: Administrative Ul Reference.

Select the chains that you want to assign to the event.

In the Redirect URIs option, specify the following redirect URIs for redirection to Filr page
after successful authentication:

+ The URI of the Filr web page
+ The URI of the Filr client application
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You can copy the URIs from the Redirection URIs option on the NetlQ Advanced
Authentication page of the Filr Administration Console (Port 8443 Filr Admin Console > >
System > NetlQ Advanced Authentication) and paste them here. See NetlQ Advanced
Authentication Configuration in the Filr 3.2: Administrative Ul Reference.

5g Click Save.
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O Language Settings

+ “About the Filr Site Default Language” on page 59
+ “Changing the Language on the Login Page” on page 59

About the Filr Site Default Language

There can be only one default language for the entire Micro Focus Filr site.

When you create Filr users, you can select a locale for each user, which determines the language of
each personal profile. However, when users who speak various languages work together on a Filr
site, they can often see interface text that is not in their preferred language. For example:

+ Standardized text such as Home Workspace, Global Workspaces, Personal Workspaces, and
Team Workspaces in the Workspace tree
+ Standardized group names, such as All Users
+ Login page
You cannot change standardized group names, such as All Users. Although the Filr login page can be

displayed in only one language, you can change the page’s default language. You must be logged in
as the Filr administrator.

Changing the Language on the Login Page

The language of the Filr login page is decided by the Guest user account. Because of this, you can
display only one language for your entire Filr site in the login page.

To change the language of the Guest user account and change the language that is displayed on the
Filr login page:
1 Navigate to the Guest profile.
2 On the Profile page, click Edit.
The User page is launched.
3 Inthe Locale drop-down list, select the language that you want to be displayed on your login
page.
Users who log in as Guest view the Filr site in the language that you select.
4 Click OK.

Each Filr user can change the language on a per-user basis by changing the Locale setting in the
user profile, as described in “Modifying Your Profile” in the Filr 3.2: User Access Guide.
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Migrating the Filr's MySQL Database to
Microsoft SQL

You can migrate the Filr database from the MySQL database appliance that ships with Filr to an
enterprise database.

This section describes how to migrate from the MySQL database appliance to Microsoft SQL.

IMPORTANT: When migrating from the MySQL database appliance to Microsoft SQL, you must first
migrate the database schema and then the data as described in this section.

+ “Prerequisites” on page 61

+ “Configuring the Existing Microsoft SQL Database Server” on page 62
+ “Connecting to the MySQL Database Server” on page 62

+ “Connecting to the Microsoft SQL Server” on page 63

+ “Customizing Data Types” on page 63

+ “Migrating the Database Schema” on page 64

+ “Migrating Data” on page 65

+ “Running Post-Migration Scripts” on page 65

+ “Post-Migration Steps” on page 66

+ “Modifying Liquibase Tables” on page 66

Prerequisites

+ Download the latest MySQL Connector/ODBC driver to the Microsoft SQL server. You can get
this driver from the MySQL development website (http://dev.mysql.com/downloads/connector/
odbc/).

This driver enables you to establish a connection between the MySQL server and the Microsoft
SQL server.

+ Download and install the Microsoft SQL Server Migration Assistant for MySQL onto the Microsoft
SQL server, as described in the Microsoft Developer Network (http://msdn.microsoft.com/en-us/
library/hh313147(v=sql.110).aspx).

+ Modify an existing user on the MySQL Appliance so that the user is associated with the IP
address or DNS name of the Microsoft SQL server where the Microsoft SQL Server Migration
Assistant for MySQL is installed. This can be accomplished via phpMyAdmin or the MySQL
appliance.

+ Stop the Filr service on any Filr appliances in the Filr system, as described in “Managing System
Services” in the Filr 3.2: Administrative Ul Reference.
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Configuring the Existing Microsoft SQL Database
Server

For information regarding which versions of the Microsoft SQL database Filr supports, see“SQL
Database Server” in the Filr 3 Installation, Deployment, and Upgrade Guide.

To configure an existing Microsoft SQL database to be used with your Filr system:

1 Enable remote access to the Microsoft SQL database server.
2 Open port 1433 on the Windows firewall where the database is running.
3 Identify a user account configured with SQL Server Authentication and that this user has

sufficient rights to manage the Filr database.

Filr supports only SQL Server Authentication. Filr does not support Windows Authentication or
Windows Domain User Authentication to Microsoft SQL.

Using Microsoft SQL Server Management Studio, create a new database to use as the Filr
database.

Select the Master database in the list of databases, then paste the following script into the New
Query window and execute it to create the new Filr database:

USE mast er;

&0

IFDBID(Nfilr') I'S NOT NULL
DROP DATABASE filr;

&0

CREATE DATABASE filr

COLLATE Latinl General 100 _BIN;
&0

--Verify the collation setting.
SELECT name, collation_name FROM sys. dat abases WHERE name = N filr"';
Q0

If your database name is something other than fi | r, replace fi | r with the name of your
database in the script.

5 Continue with “Connecting to the MySQL Database Server” on page 62.

Connecting to the MySQL Database Server

On the Microsoft SQL server, launch the Microsoft SQL Server Migration Assistant for MySQL.
Create a new project by clicking File > New Project.
The New Project dialog box is displayed.

3 Accept the defaults for the project by clicking OK.
4 Click Connect to MySql.

The Connect to MySql dialog box is displayed.
In the Provider drop-down list, select the MySQL ODBC 5.3 Unicode Driver (v5.3.x).
This option must be selected because the Filr database uses a Unicode character set.

In the Server name field, specify the IP address of the MySQL database appliance that you are
migrating from.

Specify the user name and password for the MySQL database, then click Connect.
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A connection to the MySQL server is established.
8 Continue with “Connecting to the Microsoft SQL Server” on page 63.

Connecting to the Microsoft SQL Server

1 Inthe MySql Metadata Explorer window, browse to and select your MySQL database.
2 Click Connect to SQL Server.
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3 Accept the defaults for connecting to the Microsoft SQL server, then specify the user name and
password for a user with sufficient rights on the database.

4 Click Connect.
A connection to the Microsoft SQL server has been established.
5 Continue with “Customizing Data Types” on page 63.

Customizing Data Types

1 On the Microsoft SQL server, launch the Microsoft SQL Server Migration Assistant for MySQL.
2 Click Tools > Project Settings.
The Project Settings dialog box is displayed.
3 Click Type Mapping, select bigint(*..255) in the Source Type column, then click Edit.
The Edit Type Mapping dialog box is displayed.
In the Target Type drop-down list, select Numeric (Precision, Scale).
In the Precision section, specify 19.
In the Scale section, specify 0, then click OK.

~N o o1 b~

Select datetime in the Source Type column, then click Edit.
The Edit Type Mapping dialog box is displayed.
8 In the Target Type drop-down list, select datetime, then click OK.
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9 Click Apply > OK.
10 Continue with “Migrating the Database Schema” on page 64.

Migrating the Database Schema

1 Inthe MySQL Metadata Explorer window, select the Filr MySQL database and tables that you
want to migrate, then click Convert Schema.

This creates the database schema on the target Microsoft SQL server. Ensure that the target
schema has the database _name with a . dbo extension. If the target schema does not have the
database _name or has an extension other than . dbo, then click Modify and select the correct
schema.
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2 In the SQL Server Metadata Explorer section, right-click the MySQL database that you are
migrating, then click Synchronize with Database.
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3 In the Synchronize with the Database dialog box, verify that the tables will be created, then click
OK.

4 Continue with “Migrating Data” on page 65.

Migrating Data

1 In the MySQL Metadata Explorer window, select the Filr MySQL database and tables that
contain the data that you want to migrate. Right-click and select Migrate Data.

To avoid timeout errors, migrate large tables individually, as described in Step 6.
The Connect to MySQL dialog box is displayed.

2 Accept the defaults for connecting to the Microsoft SQL server, then specify the user name and
password for a user with sufficient rights on the database.

3 Click Connect.
The Connect to SQL Server dialog box is displayed.

4 Accept the defaults for connecting to the Microsoft SQL Server, then specify the user name and
password for a user with sufficient rights on the database.

5 Click Connect.

The data is migrated. Depending on the amount of data and number of tables in your database,
this process can take a few minutes.

After the migration finishes, the Data Migration Report is displayed. You can save the report for
your records, or close it without saving.

6 (Optional) To migrate individual tables, repeat Step 1 through Step 5 and select the table that you
want to migrate in the MySQL Metadata Explorer window.

7 Run the following queries in sequence against the migrated database using the SQL Query
Editor of the Microsoft SQL Server:

ALTER DATABASE filr SET SINGLE USER W TH ROLLBACK | MVEDI ATE;

ALTER DATABASE filr COLLATE Latinl_General Cl_AS KS W5;

ALTER DATABASE filr SET MULTI _USER;

SELECT name, collation_name FROM sys. dat abases WHERE name = N filr"';

If your database name is something other than fi |l r, replace fi |l r with the name of your
database.
These queries must be successfully executed in the correct order before continuing.

8 Continue with “Running Post-Migration Scripts” on page 65.

Running Post-Migration Scripts

1 After the database schema and data is successfully migrated, run the post-migration script
(post - mi gration. sqgl ) on the migrated database by using the SQL Query Editor of the
Microsoft SQL Server. You can download the
M/SQL_MSSQL_Post _Mgration_for_Filr_3_2.sql file from the Filr 3 download site on
download.novell.com.

After running the script, you should see the following message in the SQL Query Editor for both
the Parse and Execute actions:

Command(s) conpl eted successful ly.
2 Continue with “Post-Migration Steps” on page 66.
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Post-Migration Steps

IMPORTANT: In a large Filr deployment with multiple Filr appliances, this procedure must be done
for each Filr appliance in the Filr system.

1

Access the Micro Focus Filr appliance at port 9443.
For example, https://i p_address_or_DNS: 9443

Use the IP address or DNS name of the server that you specified during the appliance
installation.

Log in to the appliance using the vaadmi n user and the password that you set.

e
¥

The Filr Server Configuration page is displayed.
Click Database.

Click the Filr Server Configuration icon

5 In the Database Type drop-down, select SQLServer.

10
11

Change the Host Name or IP Address and Port fields to match the new host name or IP address
and port number for the Microsoft SQL server.

Change the User Name and User Password fields to match that of a user on with sufficient rights
on the Microsoft SQL server.

Click OK to save the new database configuration settings.

In the Configuration Summary, verify that the database information has changed.
Click Reconfigure Filr Server,

Repeat this process for each Filr appliance in the Filr system.

Continue with “Modifying Liquibase Tables” on page 66.

Modifying Liquibase Tables

Filr ships with Liquibase scripts that validate database schema, keep track of schema changes,
compare changes with the reference database, and so forth. In order to use these scripts, the
Liguibase tables need to be deleted and re-created. (This is because the Liquibase tables contain
metadata specific for the MySQL database that you are migrating from.)

You need to remove the MySQL tables and create new tables that are compatible with the Microsoft
SQL database.

1

2

Delete the Liquibase tables (dat abasechangel og and dat abasechangel ogl ock) from the
migrated MSSQL database.

Modify the sql server-1i qui base. properti es file and set the database password to be clear
text so that it can be read by the Liquibase scripts:

2a SSH to the Filr appliance and log in to the appliance as the root user.
2b In the console of the Filr appliance, change to the / fil rinstal | / db directory.
2c Make a copy of the sql server-1i qui base. properti es file.

For example, to copy the file to the root partition:

cp sql server-1liquibase. properties /

2d Openthe sql server-1i qui base. properti es file in a text editor.
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For example, you can use the vi Editor to edit the file:
vi sql server-1|iqui base. properties
2e Change the password value to the password of the Microsoft SQL database.
2f Save and close the sql server-1i qui base. properti es file.
In the vi Editor, you can type the following command when in command mode:
LW
3 Run the manage- dat abase. sh script with the mar kDat abaseAsUpdat ed switch.

This creates the Liquibase tables and populates them with the definitions read from the Microsoft
SQL version of the changelog files that are available in the Filr installation directory.

To run the manage- dat abase. sh script with the mar kDat abaseAsUpdat ed switch:
3a SSH to the Filr appliance and log in to the appliance as the root user.
3b Run following commands:
cd /filrinstall/db
sh /filrinstall/db/ manage- dat abase. sh sqgl server narkDat abaseAsUpdat ed
4 Perform the final validation by running nanage- dat abase. sh with the updat eDat abase switch.
To run the manage- dat abase. sh script with the updat eDat abase switch:
4a SSH to the Filr appliance and log in to the appliance as the root user.

4b Get Executable permission to the nanage- dat abase. sh script by running the following
commands:

cd /filrinstall/db/
chmod x+ manage- dat abase. sh
4c Run following commands:
sh /filrinstall/db/ manage- dat abase. sh sql server updat eDat abase
sh /filrinstall/db/ manage- dat abase. sh sql server validate

The Liquibase script should find no need to perform any further schema changes, and this run
should complete without making any changes and without any errors.

5 Replace the sql server-1i qui base. properti es file that you edited in Step 2d with the one that
you copied in Step 2c.

6 Start the Filr service on any Filr appliances in the Filr system, as described in “Managing System
Services” in the Filr 3.2: Administrative Ul Reference.

7 Users can now access the Filr site at port 8443.
For example, https://i p_address_or_DNS: 8443
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2 Mobile Device Management

+ “Key-Value Pairs” on page 69
+ “Configuring ZMM to Manage the Filr App” on page 71
+ “Configuring Mobilelron to Manage the Filr App” on page 71

+ “Managing Mobile Devices with Filr” on page 77

Key-Value Pairs

Key-value pairs allow you to populate user login information and set configuration options, such as
whether the Filr app allows for opening into other apps or copying information to other apps.

Depending on your MDM solution, the key-value pairs listed here might not be necessary for setting
configuration options. For example, if you are using Mobilelron as your MDM solution, you can set
configuration options for opening into third-party apps by using the Mobilelron interface.

Table 12-1 Filr Key-Value Pairs

Key Value

server Specify the URL of your Filr site. For example,
filr.acme. com

username Specify $USERI D$ to cause Mobilelron to
automatically populate the app with the user’'s
Mobilelron user 1D

Alternatively, you can specify an individual user’s user
ID.

password Specify $PASSWORDS$ to cause Mobilelron to
automatically populate the app with the user’'s
Mobilelron password.

Alternatively, you can specify an individual user’s
password.

allowOpenlin Specify 1 as the value if you have disabled Open In or
Send To support for the mobile apps in the Filr
administration console, but you want to allow the Filr
secure app to integrate with other secure apps.

Avalue of 1 indicates that users can open Filr files into
any secure app.

Avalue of 2 allows you to designate specific apps that
users can open Filr files into. You do this by creating a
whitelist of apps using the openl nWi t el i st key.
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Key

Value

openinWhitelist

Specify 1 as the value if you want to allow the Filr
secure app to integrate with only the specific secure
apps that you designate. To designate apps for the
whitelist, specify the applications’ bundle ID (for iOS
apps) and package name (for Android apps) in a
comma-delimited list.

In order for the openl nWi t el i st values to be
recognized, the value for the al | owOpenl n key must
be set to 2.

An easy way to find the package name for an Android
app is to install the Package Name Vi ewer app from
the Google Play store. This app displays the package
name for each app that is currently installed on the
device.

To find the bundle ID for an iOS app:

1. (Conditional) If the app for which you want to
location the bundle ID has not yet been
synchronized to iTunes from your device, you
must sync the device with iTunes.

2. Inyour iTunes library on your Mac or PC, open
the Mobi | e Appl i cati ons folder.

On a Mac, this is usually in your Home directory,
at the following location: ~/ Musi ¢/ i Tunes/
Mobi | e Applications/

On Windows 7, this is usually at the following
location: C: \ User s\ user nane\ My
Musi c\i Tunes\ Mobi | e Applications/

3. Inthe Mobi | e Appli cati ons folder, locate the
app for which you want the bundle ID.

4. Create a copy of the file, and re-save the copy as
a. zipfile.

5. Unzip the newly created . zi p file.

You now see a folder by the name of the
application name.

6. Locate the i TunesMet adat a. pl i st file within
the folder and open it in a text editor.

7. Locate the sof t war eVer si onBundl ei d key
within the file.

The string value below this key is the bundle ID.

allowCutCopy

Specify 1 as the value if you want users to be able to
copy information from the Filr app and paste it into
other apps.
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Configuring ZMM to Manage the Filr App

IMPORTANT: ZENworks Mobile Management (ZMM) can be used with the iOS and Android Filr
mobile apps with the following version requirements:

+ Android requirements: Filr mobile app 1.0.3 or later with Android 4.1 or later.
+ iOS requirements: Filr mobile app 1.0.4 or later with iOS 8.0 or later.

For information about how to configure ZMM to manage the Filr app, see “Micro Focus Filr (http://
www.novell.com/documentation/zenworksmobile29/pdfdoc/
zen_mobile_organization_admin.pdf#page=41)" in the ZENworks Mobile Management 2.9.x
Organization Administration Guide (http://www.novell.com/documentation/zenworksmobile29/pdfdoc/
zen_mobile_organization_admin.pdf).

Configuring Mobilelron to Manage the Filr App

+ “Mobilelron Environment Support” on page 71

+ “Device-Specific Support Information” on page 71

+ “Adding the Filr App to Mobilelron” on page 72

+ “Pre-Populating Fields for Filr Login” on page 73

+ “Configuring Data Loss Prevention Policies” on page 75

+ “Distributing the Filr App to Devices” on page 76

+ “Preventing Frequent Prompts for a Passcode” on page 76

Mobilelron Environment Support

The Filr 3 mobile apps have been validated in the following Mobilelron environments:

¢ Sentry-AppTunneling
+ Mobilelron 7.5 AppConnect

Device-Specific Support Information

When using Mobilelron to manage the Filr app, the following features are supported:

I0OS Supported Features

+ Populate the Server IP Address field for login
+ Populate the User ID field for login
+ Open In support to allow or disallow users to open files in other applications

If you are using Mobilelron to manage devices in your organization, the Open In setting exists
both in the Filr administration console and in the Mobilelron administration console. This setting
should be consistent in both locations (if it is enabled in Filr, it should also be enabled in
Mobilelron). The one exception to this rule is if you want Open In functionality to be enabled for
devices that are being managed by Mobilelron and disabled for devices that are not being
managed by Mobilelron. To achieve this, you can enable this setting in Mobilelron and disable it
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in Filr. In this case, only devices that are being managed by Mobilelron are able to use Open In
functionality; devices that are not being managed by Mobilelron are not able to use Open In
functionality.

To configure Open In functionality for all users, see “Mobile Device Access—Default Settings” in
the Filr 3.2: Administrative Ul Reference. To configure Open In functionality for individual users
and groups, see

Android Supported Features

+ Populate the Server URL field for login
+ Populate the User ID field for login
+ Populate the User Password field for login

Adding the Filr App to Mobilelron

+ “Adding the Android Filr App” on page 72
+ “Adding the iOS Filr App” on page 73

Adding the Android Filr App

To add the Android Filr app to Mobilelron, you need to upload the . apk file and then apply the Android
label to the application:
1 Download the . apk file for the Filr mobile app from the Micro Focus downloads site.
2 Upload the file to Mobilelron.
2a In the Mobilelron Admin Portal, click the Apps tab.

2b Onthe App Distribution Library tab, in the Select Platform drop-down list, select the
platform for the app that you want to add. For example, if you are uploading the Filr mobile
app for Android, select Android.

2c Click Add App.
The Add App Wizard is displayed.

2d Click Next, then specify the following information:
Distribution Type: Select In-house App.

Silently Install: If your device supports a silent install, you can select Yes. If the device
does not support a silent install or you are unsure, select No.

App Upload: Browse to and select the . apk file that you downloaded in Step 1.

2e Click Next, then specify the following information:
App Name: M cro Focus Filr is already specified for you. This cannot be changed.
Display Version: The version is already specified for you. This cannot be changed.
Code Version: The version is already specified for you. This cannot be changed.
Description: Specify a short description for the app.

Override URL: For information about this feature, see the blue information icon next to this
field.

Featured: Select whether you want to feature this app.

Category: Select the category that most closely matches the app. You can add a new
category as described in the dialog box.
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2f Click Next, then click Browse to upload any screen shots that you have for the app.
The mandatory image size is displayed in the dialog box.
2g Click Finish to close the Add App Wizard.
3 Apply the Android label to your application:

3a From the App Distribution Library tab on the Apps tab, select the Micro Focus Filr app that
you just created, then click Actions > Apply To Label.

The Apply To Label dialog box is displayed.
3b Select the Android label, then click Apply > OK.

Adding the iOS Filr App

To add the iOS Filr app to Mobilelron, you need to import it from the Apple Appstore and then apply
the iOS label to the application:
1 Import the app from the Apple Appstore.
1la In the Mobilelron Admin Portal, click the Apps tab.
1b Onthe App Distribution Library tab, in the Select Platform drop-down list, select iOS.
1c Click App Store Import.
The App Store Search dialog box is displayed.
1d Inthe App Name field, type M cro Focus Filr.
le Inthe App Store field, select the country appropriate to your location.
1f Click Search.
1g Click Import next to the Micro Focus Filr app, then click OK after it is imported.
1h Close the App Store Search dialog box.

1i From the App Distribution Library tab on the Apps tab, click the Edit icon next to the Micro
Focus Filr app that you just imported.

The Edit App for iOS dialog box is displayed.
1j Make any desired changes to the app details and icon, then click Save.
2 Apply the iOS label to your application:

2a From the App Distribution Library tab on the Apps tab, select the Micro Focus Filr app that
you just created, then click Actions > Apply To Label.

The Apply To Label dialog box is displayed.
2b Select the iOS label, then click Apply > OK.

Pre-Populating Fields for Filr Login

You can pre-populate the fields on the Filr login screen for users in your system by configuring the Filr
key-value pairs in Mobilelron. You can pre-populate the server URL and user ID fields for both the
iOS and Android apps. For the Android app, you can also pre-populate the user password field.

You accomplish this within Mobilelron by modifying the app configuration for Android, and by creating
a new app configuration for iOS.

+ “Modifying the Android Filr App Configuration for Mobilelron” on page 74
+ “Creating the iOS Filr App Configuration for Mobilelron” on page 74
+ “Key-Value Pairs” on page 74
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Modifying the Android Filr App Configuration for Mobilelron

1 In the Mobilelron Admin Portal, click the Policies & Configs tab.

2 Onthe Configuration tab, in the Name column, click the name of the Filr configuration for the Filr

app that you uploaded, as described in “Adding the Android Filr App” on page 72.

Click Edit.

The Modify AppConnect App Configuration dialog is displayed.

Specify the following information:

Name: Provide a name for the configuration, or keep the default.

Description: (Optional) Provide a description for the configuration, or keep the default.
Application: Select M cro Focus Filr from the drop-down list.

In the App-specific Configurations section, keep or remove the key-value pairs that are shown
in Table 12-2, “Filr Key-Value Pairs,” on page 75. Key-value pairs that remain in the table
represent the information that will be pre-populated for Filr login.

6 Click Save.

Creating the iOS Filr App Configuration for Mobilelron

1 In the Mobilelron Admin Portal, click the Policies & Configs tab.

On the Configuration tab, click Add New > AppConnect > Configuration.

The New AppConnect App Configuration dialog box is displayed.

Specify the following information:

Name: Provide a name for the configuration, such as Fil r i GS Confi gurati on.
Description: (Optional) Provide a description for the configuration.

Application: Specify the Filr iOS bundle ID, which is com novel | . vi befilr.

In the App-specific Configurations section, click the Plus icon to add a new field to the key-
value pair table; you can then specify the key-value pair to be included in the configuration. The
key-value pairs that you can add are shown in Table 12-2, “Filr Key-Value Pairs,” on page 75.
Key-value pairs that you add to the table represent the information that will be pre-populated for
Filr login.

Click Save.

Key-Value Pairs

If you modify key-value information after the Filr app has already been pushed to user devices,
devices where the app is already installed are not refreshed with the updated information.
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Table 12-2 Filr Key-Value Pairs

Key Value

server Specify the URL of your Filr site. For example,
filr.acme.com

username Specify $USERI D$ to cause Mobilelron to
automatically populate the app with the user’'s
Mobilelron user ID.
Alternatively, you can specify an individual user’s user
ID.

password Specify $PASSWORDS$ to cause Mobilelron to

automatically populate the app with the user’'s
Mobilelron password.

Alternatively, you can specify an individual user’s
password.

Configuring Data Loss Prevention Policies

You can configure policies to restrict users from performing actions that could lead to data loss. For
iOS devices, you can restrict users’ ability to print, copy or paste, and open in other apps. For
Android, you can restrict users’ ability to take a screen capture.

You accomplish this within Mobilelron by modifying the app policy for Android, and by creating a new

app policy for iOS.

+ “Modifying the Android Filr App Policy for Mobilelron” on page 75

+ “Creating the iOS Filr App Policy for Mobilelron” on page 76

Modifying the Android Filr App Policy for Mobilelron

1 In the Mobilelron Admin Portal, click the Policies & Configs tab.

2 In the Name column, click the name of the Filr policy for the Filr app that you uploaded, as
described in “Adding the Android Filr App” on page 72.

3 Click Edit.

The Modify AppConnect App Container Policy dialog is displayed.

4 Specify the following information:

Name: Provide a name for the policy, or keep the default.

Description: (Optional) Provide a description for the policy, or keep the default.

Application: Select M cro Focus Filr from the drop-down list.

5 Inthe Data Loss Prevention Policies section, you can change the following configuration option

for Android devices:

Screen Capture: Allow users to take a screen capture from within any AppConnect app

(including Filr).
6 Click save.
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Creating the iOS Filr App Policy for Mobilelron

1 In the Mobilelron Admin Portal, click the Policies & Configs tab.

2 On the Configuration tab, click Add New > AppConnect > Container Policy.
The New AppConnect App Configuration dialog box is displayed.

3 Specify the following information:
Name: Provide a name for the policy, suchas Filr i GS Policy.
Description: (Optional) Provide a description for the policy.
Application: Specify the Filr iOS bundle ID, which is com novel | . vi befilr.

4 Inthe Data Loss Prevention Policies section, you can change the following configuration options
for iOS devices:

Print: This setting is not honored in the Filr app. There is no printing ability from within the Filr
app.
Copy/Paste To: This setting is ignored in this release of the Filr mobile app. Copy/Paste

functionality is included in the Open In setting. In other words, you must disable Open In in order
to disable Copy/Paste.

Open In: Allow users to use the Open In functionality. If allowed, specify whether users can
open into all apps on the device, only into AppConnect apps, or only into a list of apps that you
specify.

To specify individual apps via the whitelist option, specify the apps bundle ID. For example, the
bundle ID for the Pages app is com appl e. i wor k. pages.

5 Click Save.

Distributing the Filr App to Devices

You need to distribute the Filr app to devices in your organization via Mobilelron if this is the first time
your organization is using Mobilelron with Filr, or any time a new device enters the organization.

It is possible that some users independently download the Filr app from the app store before their
device is managed by Mobilelron. In this case, you still need to push the app to their device via
Mobilelron. (These devices will lose any cached or downloaded files within the Filr app after their
device becomes managed and the Filr app is pushed to their device.)

Preventing Frequent Prompts for a Passcode

Each time the Filr app checks in with Mobilelron, it is briefly forced into the background by the
Mobilelron app. This happens so quickly, that users might not notice unless they are looking directly
at the screen.

When the Filr app returns to the foreground, if it is set to require an Access Passcode/PIN, the user is
prompted for the code.

To control how often app users are interrupted, access the Mobilelron administrative console and
adjust the Global Policy > App Check-in Interval.
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Managing Mobile Devices with Filr

You can view users who have accessed your Filr system from a mobile device, and if necessary, wipe
all Filr data from the user’s device.

For more information, see Viewing, Wiping, and Disconnecting Registered Clients.
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Monitoring

For information on all Filr monitoring capabilities, see “Logging and Monitoring” in the Filr 3.2:
Administrative Ul Reference.

+ “Enabling Debug Logging” on page 79

+ “Monitoring with Ganglia” on page 81

+ “Monitoring File Meta-Data Synchronization in a Filr Cluster” on page 86

+ “Monitoring the Indexing Process” on page 87

+ “Monitoring User Access, including the Guest User” on page 88

Enabling Debug Logging

IMPORTANT: Do not adjust the settings described in this section unless you are instructed to do so
by a Filr support engineer.

Adjusting the settings without guidance from Filr support can negatively impact the performance of
your Filr deployment.

+ “Enabling Debug Logging for Filr” on page 79
+ “Enabling Debug Logging for FAMT” on page 80
+ “Configuring Debug Logging for SMB Communications” on page 80

Enabling Debug Logging for Filr

IMPORTANT: These steps should only be followed in consultation with a Filr support engineer.

1 In a text editor, open the | og4j . properti es file from both of the following directories:
lopt/ novel I /filr/apache-tontat/conf

2 Uncomment each line for which you want to enable debug logging in the | og4j . properti es file.
For example, to trace file synchronization and accesses through mirrored folders, uncomment
the following lines in the | og4j . properti es file:

| og4j . cat egory. com novel | .t eam ng. nodul e. f ol der. i npl . Pl usFol der Modul e=DEBUG
| og4j . cat egory. org. kabl i nk. t eam ng. nodul e. file.inpl.Fil eMdul el npl =DEBUG

| og4j . cat egory. org. kabl i nk. t eam ng. f i =DEBUG

| 0og4j . cat egory. com novel | .t eam ng. fi =DEBUG

| og4j . cat egory. com novel | .t eam ng. repository. fi =DEBUG

To trace interactions with resource drivers, uncomment the following lines in the
| og4j . properti es file:
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| og4j . cat egory. org. kabl i nk.t eami ng. util . Traceabl el nput St r eam apper =DEBUG
| og4j . cat egory. com novel | . team ng. fi. Traceabl eAcl Resour ceDri ver W apper =DEBUG
| og4j . cat egory. com novel | .t eam ng. fi. Tr aceabl eAcl Resour ceSessi onW apper =DEBUG

3 Monitor the / var/ opt / novel | /tontat-filr/logs/appserver. | og file.

Enabling Debug Logging for FAMT

IMPORTANT: The instructions in this section should only be followed in consultation with a Filr
support engineer.

+ “Setting Debug Logging for FAMT” on page 80
+ “Viewing FAMT Log Files” on page 80
¢ “Clearing FAMT Log Files” on page 80

Setting Debug Logging for FAMT

1 From the command line of the Filr appliance, change to the following directory:
/opt/novel | /filr/bin
2 Set the FAMT log level as follows:
./famconfig -s loglevel 4
or
To view the current log level:
./famconfig -g | ogl evel

Viewing FAMT Log Files

1 Change to the following location on the Filr server:
/var/opt/novel I /filr/log

The f ant d. | og, debug, and core files are available for debugging functionality issues related to
FAMT.

Clearing FAMT Log Files

1 Run the following command to clear the log files:
/etc/logratoate.d/ novell-fant-1ogs
FAMT logs are rotated after the log size exceeds 5MB.

Configuring Debug Logging for SMB Communications

IMPORTANT: These steps should only be followed in consultation with a Filr support engineer.

The /var/opt/novel | /filr/log/smbclient.!|oglog file captures SMB/CIFS communications with
Net Folders on Windows and Micro Focus OES servers (including OES for NSS AD).
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About the smbclient.log File

Filr support engineers use the information captured in the smbclient.log file to troubleshoot SMB
communication issues.

Log levels can range from 1 (the default) to 10. Each increase in level causes the system to log
additional information.

The snbcl i ent. | og file gets rotated to snbcl i ent . | og. ol d when it reaches approximately 5 MB in
size. Depending on the scope of the issue being addressed, your Filr support engineer might instruct
you to increase the log-file size setting by modifying the max | og si ze parameter under the

[ gl obal ] section of the snb. conf file.

Your Filr support engineer might also ask you to redirect log output to another file by using the
following command at the terminal prompt: # tail -F /var/opt/novell/filr/l og/
snbclient.log >> file-name-with-path

Changing the Debug Level

As directed by a Filr support engineer, do the following:
1 At the appliance terminal prompt, launch a text editor such as VI and open the smb.conf file
located here:
/etc/opt/novel I /filr/.snb/snb.conf

2 Add a parameter to control the SMB log level by inserting the following line under the [ gl obal ]
section in snb. conf :

| og | evel = nunber-specified-by-Filr-support-engi neer
3 Save the smb.conf file.
4 Restart famtd by entering the following command:

# rcnovel | -fantd restart

5 After your support issue is resolved, ensure that you reset the log level to 1 and restart f ant d by
using the instructions above.

Monitoring with Ganglia

Ganglia is a scalable, distributed monitoring system that lets you gather important metric data about
your Filr system